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IBM Aspera Connect is an install-on-demand application that facilitates high-speed uploads and downloads with an

Aspera transfer server.

Connect is compatible with most standard Web browsers. It integrates all of Aspera's high-performance transport
technology in a small, easy-to-use package that provides unequaled control over transfer parameters. Connect
includes the following features:

Feature

Description

FASP file transport

High-performance transport technology.

Browser interface

Uploads and downloads are launched transparently by a Web browser.

Flexible transfer types

Easily transfer single files, multiple files, or entire directories.

Transfer retry and resume

Automatically retries and resumes partial and failed transfers.

Browser-independent
transfer

The Web browser can be closed once transfer operations have begun.

Transfer monitor

A built-in transfer monitor for visual rate control and monitoring.

HTTP fallback

HTTP fallback mode for highly restrictive network environments.

Proxy support

HTTP fallback and FASP proxy settings.

Content protection

Password-protect files that are being transferred and stored on the remote server.

Queueing

Allow a fixed number of concurrent transfers, and place the rest in a queue.

folders

Drag-and-Drop of files and

When used with IBM Aspera Faspex and some third-party web applications, Connect
supports drag-and-drop for specifying which files and folders to transfer.

Setting Up Connect

Installation

The procedure for installing IBM Aspera Connect requires enabling a browser extension for Connect in addition to
installing the Connect application itself.

There are two ways to install Connect on your system:

* Guided Installation: The most common way of installing Connect. If Connect is not installed or needs upgrading
when you try to upload or download files from an Aspera web app, such as Aspera Faspex or Aspera Shares, you
are prompted to install Connect and guided through the process.

* Manual Installation: For system-wide (multi-user) installations, and a fallback method for users with non-typical
web apps. You first install the Connect web extension for your browser (with the exception of Safari). You then
install the Connect application by running a desktop installer you download from the Aspera website.

System Requirements: For information on supported operating systems and browsers, see the release notes for this
version of IBM Aspera Connect.

Important:
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» Before performing a system-wide installation (all users of the machine), uninstall any per-user installations. For
details, see Uninstalling on page 27.

* Remove all previous Connect installers before downloading the new installer.

» Connect works better when your browser's local storage is enabled; however, it is not a requirement.

Guided Installation

If you do not have Connect installed and you attempt to transfer packages or files using an Aspera web application
(such as Faspex or Shares), the Connect Welcome screen appears and prompts you to install Connect:

Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.9.5.

Mew
Step 1 % Install Extension
Step 2 \L

Already installed? Troubleshoot

Depending on your browser/platform combination, the screens shown in these instructions may vary.
1. To begin, click Install Extension.

Your browser's page for the Connect extension opens. See the instructions for your browser in Adding the
Connect Browser Extension on page 7 to install the Connect extension. If successful, you'll see the message
confirming the extension has been added.

2. The welcome screen now prompts you to download the Connect application:
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Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.9.5.

New

© step1 [E‘i
1
o2 [ (I
Step 3

Already installed? Troubleshoot

Click Download the App. The following message appears as the installer (.exe, .dmg, or .rpm, depending on your
0S) is downloaded to your Downloads folder.

Please wait.
Downloading the

Connect app
installer...

Once the installer has been downloaded, the following message appears:

Please run the

Connect app
M EE

3. The welcome screen now prompts you to install the Connect application:
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Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.9.5.

New

oy
Y
@ step1 [‘“"L—}’

Already installed? Troubleshoot

To install the Connect application, locate the installer app you just downloaded, open it, and click Start.

[ X | IBM Aspera Connect Setup

G

To install IBM Aspera Connect, click Start.

Start

By installing, you agree 1o the IBM Aspera license agreement

Once the Connect application has been installed, refresh your browser.

Manual Installation
Step 1. Install the Connect extension for your browser.

For instructions about obtaining the Connect extension for your browser, see Adding the Connect Browser Extension
on page 7.

Step 2. Download and run the Connect application installer.

You can download the Connect installer DMG directly from http://downloads.asperasoft.com/connect/. Once

downloaded, close your Web browser and run the installer on your machine. You will need to accept the terms and
conditions and click Install.

If macOS complains that Connect cannot be installed because the app did not come from the Apple App store, you'll
need to enable the installation in your Mac's security settings:


http://downloads.asperasoft.com/connect/
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1. Open the System Preferences > Security & Privacy > General tab. The Security & Privacy window opens.

2. Unlock the screen to make changes by clicking on the padlock icon in the lower-left corner, circled in the
screenshot below.

3. Set Allow apps downloaded from: to App Store and identified developers.

@ < i Security & Privacy Q fse

Ll FileVault  Firewall  Privacy

A login password has been set for this user  Change Password...

v Require password immediately T after sleep or screen saver begins
Show a message when the screen is locked

Allow your Apple Watch to unlock your Mac

Allow apps downloaded from:

Elick the lock to make changes. 2

Adding the Connect Browser Extension

For supported web browsers, this section explains how to obtain and add the IBM Aspera Connect extension to the
browser you will use. The Connect extensions are specific to the browser; the procedure for adding an extension to

a browser is the same regardless of which OS platform that browser is running on. With a guided install, clicking
Install Extension opens the extension link for the browser you are using. With a manual install, be sure to download
the extension for the browser you intend to use with Connect.

Chrome
To obtain and install the Connect extension for Chrome, follow the procedure below:

1. Click Install Extension (guided install method), or open the IBM Aspera Connect page on the Chrome Web Store
(manual install method). The following page opens:


https://chrome.google.com/webstore/detail/ibm-aspera-connect/kpoecbkildamnnchnlgoboipnblgikpn
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&~ chrome web store o

G IBM Aspera Connect

Offered by: IBM Aspera

% % % % % 1| Productivity | & 261users

Overview Reviews Related

1GB
C:fUsers/dev/Downloads/1GE
Downloading 496.4 f 1,000.0 ME (399.22 Mbps) - 0:04 remaining 0:11 elapsed

2. Click Add to Chrome. The Add "IBM Aspera Connect"? popup appears.
3. Click Add extension.

@J Add "IBM Aspera Connect"?

It can:
Read and change all your data on the websites you wisit

Communicate with cooperating native applications

e

If successful, you'll see the message "IBM Aspera Connect has been added to Chrome".

Note: By default, the Connect extension is disabled in Chrome's incognito mode. To enable the Connect extension,
right-click the small Connect icon in the upper-right corner of your browser page. Then open Manage extensions
and scroll down to the heading Allow in incognito. Then set the switch to ON as shown below. Note that the Connect
extension does not record browser history.

Allow in incognito
Warning: Google Chrome cannot prevent extensions from recording your browsing history. To disable ®
this extension in incognito mode, unselect this option.

Firefox
To obtain and install the Connect extension for Firefox follow the procedure below:

1. Click Add extension (guided install method), or open the IBM Aspera Connect page on the Firefox Add-Ons
page (manual install method). The following page opens:


https://addons.mozilla.org/en-US/firefox/addon/ibm-aspera-connect/
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t) FirEfox Add—ons E re  Extensions Themes  More... v

IBM Aspera Connect
by IBM Aspera

This add-on enables the use of IBM Aspera Connect with Firefox. This add-on
requires the IBM Aspera Connect application, version 3.9.0 or newer. + Add to Firefox

U

IMPORTANT: If you encounter an error "Download failed. Please
check your connection”, update Firefox.

2. Click + Add to Firefox. The Add IBM Aspera Connect? popup appears.

?ii-' & Mozilla Foundation (US) | https://addons.mozilla.on

G Add IBM Aspera Connect?
1

It requires your permission to:

& Access your data for all websites

® Exchange messages with programs other than Firefox
& Access browser tabs

Cancel

3. Click Add.

If successful, you'll see the message "IBM Aspera Connect has been added to Firefox".
Safari 12

For Safari the Connect browser extension is provided with the macOS installer for Connect. For this reason, the

extension cannot be added to Safari until affer the installer has been run. Once Connect is installed, add the Connect
extension to Safari as follows:

1. Open Safari > Preferences (not Safari Extensions):
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[ File Edit View History

About Safari
Safari Extensions...

Preferences... 3,
Settings for This Website... k

Clear History...

Services >

2. Select the Extensions tab. The Extensions window appears.

® ® Extensions

ol L § Quw O @ B &

General Tabs AutoFill Passwords Search Security Privacy Websites Extensions Advanced

v @ IBM Aspera Conn... IBM Aspera Connect 3.9.5
\ G
o |

£

Enable this extension to use |IBM Aspera Connect with Safari.

Uninstall

Permissions for "IBM Aspera Connect™

Webpage Contents

Can read sensitive information from webpages, including passwords, phone
numbers, and credit cards on:

3. Look for the IBM Aspera Connect extension listed in the left panel, and click the checkbox to select it.
4. Close the dialog. The Connect extension has been added to your browser.

After Installation
Once Connect is installed, you can open it from one of the following locations:

For a system-wide installation (all users on the machine): Macintosh HD > Applications > Aspera Connect

For per-user installations: Macintosh HD > Users > home_dir > Applications > Aspera Connect

Tip: Aspera provides a web-based diagnostic tool that can be helpful in identifying connection issues. You can
access the IBM Aspera Connect Diagnostic Tool here:

https://test-connect.asperasoft.com/



https://test-connect.asperasoft.com/
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Network Environment

Connect typically requires some configuration steps in order to function in your network environment. Configuration
settings also allow you to limit transfer rates and use an HTTP proxy.

If you need to configure any network proxies or override network speeds, you can do so through Connect's Network
option. Before modifying Connect's network configuration, review the network requirements below, which describe
ports that may need to be open on your network (such as ports 22 and 33001).

Network Requirements

Your SSH outbound connection may differ based on your organization's network practices. Although TCP/33001 is

the default setting, consult your IT department for questions related to which SSH ports are open for file transfer. Also
see the help documentation for your particular operating system, for specific instructions on configuring your firewall.
If your client host is behind a firewall that does not allow outbound connections, you will need to allow the following:

* Outbound connections for SSH, which is TCP/33001 by default, although the server side may run SSH on another
port. Check with your IT department for which SSH ports are open for file transfers.

» Outbound connections for FASP transfers, which is UDP/33001 by default, although the server side may run
FASP transfers on one or more other ports. Check with your IT department for which SSH ports are open for
FASP transfers.

Limit Transfer Rates

Important: Set values in these fields only if you need to limit the bandwidth that Connect uses. For example, your
office may have limited bandwidth to share among its users. Exception: For the SaaS products Files and Aspera on
Cloud, use this field to set the default transfer speed.

Launch Connect as follows:
For a system-wide installation (all users on the machine): Macintosh HD > Applications > Aspera Connect
For per-user installations: Macintosh HD > Users > home_dir > Applications > Aspera Connect

Open Preferences:

From the menu bar: & > Preferences
smn®s © 2 o @
Activity #BT |

Unlock Encrypted Files  3ER
Open Log Folder ®L

Check For Updates L ETTT
About... {rF1
Quit ®Q

You can limit Connect transfer rates from the Bandwidth tab:
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[ ] Preferences - IBM Aspera Connect

s It a5 AN 1

General Transfers Network Bandwidth Security

Transfer speeds depend on server settings and your network connectivity. The settings below allow
you to limit transfer rates.

Limit Download to: Mbps

Kbps
Limit Upload to: 100

You can limit the download and upload transfer rates by enabling the respective checkboxes and entering a rate in
either Mbps or Kbps. Note that setting a maximum speed doesn't guarantee your transfers will ever achieve that
speed. Actual performance depends on the following factors:

* Your network's bandwidth: Available bandwidth on your network may limit your transfer rate, even if you enter
larger numbers into these fields.

* Your Aspera server transfer settings: Settings on your server may limit your transfer rate even if your network
bandwidth and the numbers you enter are larger.
HTTP Proxy

HTTP fallback serves as a secondary transfer method when the Internet connectivity required for Aspera accelerated
transfers (UDP port 33001, by default) is unavailable. If UDP connectivity is lost or cannot be established, if you have
configured an HTTP proxy, the transfer continues over the HTTP protocol based on this proxy configuration.

Note: Although the HTTP proxy is used primarily for the HTTP fallback feature, it can be used for all HTTP-related
activities performed by Connect. However, it cannot be used for FASP transfers.

To configure and enable an HTTP proxy server, open Preferences > Network in Connect and look for the HTTP
Proxy section.

[ ] Preferences - IBM Aspera Connect

e "t T M 1

General Transfers Metwork Bandwidth Security

Configure proxy settings.
HTTP Proxy
Obtain proxy configuration from | Manual d

Use HTTP Proxy

User name: | alyx
Password: ssssss

Address: 10.0.0.9 Port: 3888

To configure the HTTP proxy, select one of the following configuration methods from the drop-down list:
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» System — to have Connect use the HTTP proxy settings that are configured for your operating system.
* Manual — to enter your HTTP proxy settings manually. (This may require the assistance of your system
administrator.)

These settings include username and password authentication credentials, as well as the host name, IP address, and
port number.

Note that the Use HTTP Proxy checkbox and fields are enabled only if you select Manual.

FASP Proxy

When FASP proxy is enabled, Aspera passes the DNAT or DNATS (secure) username, password, server address, and
port to ascp.

To set up a FASP proxy, do the following:

1. Go to Preferences > Network in Connect and locate the FASP Proxy section in the lower half of the dialog.
2. Select the following checkboxes:

* Use FASP Proxy (DNAT)
* Secure (DNATS)
3. Enter your proxy server username, password, address, and port number.

FASP Proxy
Use FASP Proxy (DNAT)
Secure (DNATS)

User name: | proxy_user
Password: sessssesse

Address: | 10.0.8.9 Port: (7777

Note: If you enable FASP proxy, you may need to add 1ocal.connectme.us as a proxy exception in order for
Connect to function.

Basic Configuration

The Connect Preferences dialog allows you to configure logging behavior and various options for file transfers, such
as transfer queuing, file download location, and the allowed number transfer retries.

To change the application's default settings, launch Connect as follows:
For a system-wide installation (all users on the machine): Macintosh HD > Applications > Aspera Connect
For per-user installations: Macintosh HD > Users > home_dir > Applications > Aspera Connect

Open Preferences:

From the menu bar: &G > Preferences



sSpAe O t 70 ®

| Activity #T |
Unlock Encrypted Files  3ER
Open Log Folder ®L
Preferences... &P
Check For Updates ®U
About... {rF1
Quit ®Q

General Preferences

Connect's general application behavior can be configured in the General tab.

r

[ ] Preferences - IBM Aspera Connect
i ] .l.'t "-!;: N L

General Transfers MNetwork Bandwidth Security

Manually

Remove transfer list itemsEal [« RIS TR EET 5 =

Lo

Logging level:  Info

Under the General tab, you can modify the following settings:
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» Specify how to remove transfer sessions from the Activity window: manually, or automatically on successful

transfers.
» Specify the level of detail to be logged for transfers:

» Info — Default. Displays general messages about requests, ascp spawn options, and transfer status changes.

* Debug — Verbose. Displays validation and FASP management messages, and passes —D to ascp.
* Trace — Extra verbose. Passes —DD to ascp. Used only for diagnosing problems.



[ ] Preferences - IBM Aspera Connect

3 7 ) EH N 1

General Transfers Network Bandwidth Security

Remowve transfer list items:  Manually

Logging Ievem
Debug

Trace

B

The logging feature is typically used for troubleshooting and when contacting Aspera Support.

Transfer Preferences

Connect's transfer behavior can be configured under Preferences > Transfers.

[ ] Preferences - IBM Aspera Connect

@ b 1 ‘i;-: N L

General Transfers MNetwork Bandwidth Security

Downloads location: | jUsersfjack/Downloads Browse...

Always ask me where to save downloaded files.

Queue: Enable gueuing

Maximum concurrent transfers: 3

Retry: Automatically retry failed transfers
Attempts: |3

Interval: |30 seconds a

The interval specifies an amount of time that will elapse between
each attempt to restart a failed transfer.

Downloads
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By default, Connect downloads files to the current user's Downloads folder. To change this setting, adjust the

following settings:

* Save downloaded files to — Specify the path to the location where downloaded files should be saved.

* Always ask me where to save downloaded files — Choose this option to select a location for each download.

Queue
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* Enable queuing — Enable or disable the queuing of transfers.

*  Maximum concurrent transfers —This allows a specified number of transfers to run concurrently and places the
remainder in a queue.

Retry
You can set a retry rule if a transfer fails. Set the retry rule as follows:

* Automatically retry failed transfers — enable or disable.
* Attempts — specify the number of times Connect should attempt to retry a failed transfer.

» Interval — specify the amount of time that Connect should wait before retrying a transfer (in seconds, minutes, or
hours).

Security Configuration

Connect security facilities allow you to specify restricted and trusted hosts, encrypt content, and manage
authentication credentials.

features the following capabilities for minimizing security risks when uploading or downloading files:

*  You can add Aspera servers as Trusted Hosts to avoid the recurring security prompt, or add servers to the
Restricted Hosts list to require confirmation every time you attempt to initiate a transfer with that host.

* You have the option of saving your authentication credentials when you connect to a server, as well as removing
them from the Passwords tab.

» Content protection is a feature that allows uploaded files to be encrypted during a transfer for the purpose of
protecting them while stored on a remote server. The uploader sets a password while uploading the file, and the
password is required to decrypt the protected file.

The settings above can be configured in the Connect Preferences dialog. To open it, first launch Connect:
For a system-wide installation (all users on the machine): Macintosh HD > Applications > Aspera Connect

For per-user installations: Macintosh HD > Users > home_dir > Applications > Aspera Connect

Then, from the menu bar: & > Preferences

sSEBhnm © 3 0 @
Activity #BT |

Unlock Encrypted Files  3ER
Open Log Folder ®L

Check For Updates L ETTT
About... {rF1
Quit ®Q

Managing Hosts

When a transfer is initiated and the Use my choice for all transfers with this host option is enabled in the
confirmation dialog, the server that you are allowing or denying will be added to the Trusted Hosts or Restricted
Hosts list, respectively. To view, add or remove additional trusted hosts, go to Security > Trusted Hosts. Enter the
host's address in the specified text field and click Add.
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[ ] Preferences - IBM Aspera Connect

3w N 1

General Transfers Network Bandwidth Security

ed Ho Restricted Hosts ~ Passwords  Content Protection

Trusted hosts are hosts to which you have granted permission to always allow transfers. If
any attempt is made to start a transfer with a host that is not on this list, you will be given the
option to allow or deny the transfer.

Address: Add
L3

Host Remove
https:/fdemo.asperasoft.com

https://faspex.com Remove All

To view, add or remove restricted hosts, go to Security > Restricted Hosts. Here, enter the host's address in the
specified text field and click Add.

[ ] Preferences - IBM Aspera Connect

3 2 ) £ N f

General Transfers Network Bandwidth Security

Trusted Hosts | Restricted Hosts | Passwords  Content Protection

Restricted hosts are hosts for which you have enabled enhanced security. If any attempt is
made to start a transfer with a host that is on this list, you will be presented with a warning
before it can proceed.

Address: Add
[N

Host Remove

https:/fwww.untrustedhost.com
Remove All

Important: By adding a host to the restricted list, you will be required to provide confirmation every time you
attempt to initiate a transfer with that host.

To view, add, or remove saved password information for a host, go to Security > Passwords. Here, you can remove
saved login credentials; however, you cannot add credentials to this list directly. Whenever you attempt a transfer
with a server where your credentials are not saved, you are prompted with an authentication dialog and offered a
Remember this password checkbox. Marking the checkbox causes your login credentials to be saved and appear in
this tab.
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[ ] Preferences - IBM Aspera Connect
3 \'1 ::'.: AN 1
General Transfers Network Bandwidth Security
Trusted Hosts ~ Restricted Hosts | Passwords | Content Protection
Login information has been saved for the following hosts:
Host User Remove

https://10.0.204.100 aspl Remaove All
https://198.23.89.123 asperaweb

Content Protection

To specify hosts to which you want all uploads to be encrypted, open the Content Protection tab under Security. In
the Address field enter the Aspera server address and click Add. The server is then added to the list.

r b |
[ ] Preferences - IBM Aspera Connect

@ M et N L]

General Transfers Metwerk Bandwidth Security

Trusted Hosts  Restricted Hosts ~ Passwords ontent Protection
Content protection allows you to leave files encrypted on servers to which they have been
uploaded. Enter a list of hosts for which you want to enable this functionality.

Address: Add
L3

Host Remove

https:/fdemo.asperasoft.com
Remove All

When uploading files to a server on the list, or one that is configured as a content-protected host, you are prompted
for a passphrase to encrypt the files. You can also choose not to encrypt files if the server allows it.

For details on encryption and decryption, see File Encryption.

Connect Functionality

Initiating a Transfer

You can use Connect with the Aspera demo server to test basic transfer functionality and also familiarize yourself
with how to initiate uploads and downloads.

The steps below describe how to initiate a file transfer, and shows how to perform a download from Aspera's demo
server.
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Important: In order for Connect to function correctly, your browser must have cookies enabled. For instructions on
verifying this setting, see the help documentation for your browser.

1. Open your web browser and log in to Aspera's demo transfer server at http://demo.asperasoft.com/aspera/user.
Enter the following credentials when prompted:

» User: asperaweb
* Password: demoaspera
2. In, open the folder aspera-test-dir-large.
To select a file or folder you want to download, click the checkbox next to it. You can also click multiple boxes to

select more than one file or folder to download at a time. Once you've made your selections, click the Download
button.

@ Welcome asperaweb (change user)

=4 aspera connect server

demo.asperasoft.com > aspera-test-dir-large

aspera-test-dir-large

g Download 4 Upload #Upload Folder a Delete aMew Folder
Name Size Last Modified
% Pparent Directory
§ 100MB 100MB Apr 10, 2014 10:49:29 AM
g 10GB 10GB Apr 10, 2014 10:49:04 AM
s 1GB 1000MB Apr 10, 2014 10:49:23 AM
§ 200MB 200MB Apr 10, 2014 10:49:27 AM

3. Confirm the download.

A dialog appears asking you to confirm whether the transfer should proceed. Select Allow to begin. To skip this
dialog in the future, enable the checkbox Use my choice for all connections with this host.

@ Confirm - IBM Aspera Connect

v Anattempt is being made to connect with
(! 198.23.890.123.
Do you want to allow this?

Use my choice for all connections with this host

SR | Deny

4. Enter credentials to authenticate the transfer.

The following dialog appears asking for a username and password. Fill in the server account name and password.

Note: If the server OS is Windows and the you are using a domain account, all characters in the domain name
must be uppercase.


http://demo.asperasoft.com/aspera/user
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Authenticate - IBM Aspera Connect

v Login to: 198.23.88.123

|_-o

User Mame:
Password:

Remember this password

G | cence

You can also use the Aspera demo server to upload files. When you log in to the server, open the Upload folder.
Click the Upload button to select files from your system to upload to the demo server. You can use the checkboxes to
select multiple files to upload at once. To select folders to upload, click Upload Folder.

Note: When uploading, do not transfer files whose names contain the following characters:

/N " . 2 > < & x|

Once you confirm that the configuration settings are correct and that Connect is working properly, you can begin
transferring with your organization's Aspera server. To get started, simply point your browser to your server's host
name. For example, if the server is running IBM Aspera Connect Server:

http://server host name/aspera/user

Note that the URL format of the address can be different, depending on your server product.

The Activity Window

In the Activity window, you can view and manage all transfer sessions. From here you can stop a transfer, resume it,
retry a failed transfer, and open the location containing the content.
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[ NN | Activity - IBM Aspera Connect

W S IMG_4333.CR2

Done

LHl- IMG_4336.CR2
— J[Usersfjan/Downloads/IMG_4336.CR2.aspera-env

Downloading 7.8 / 18.9 MB (9.73 Mbps) - 0:10 remaining 07 elapsed

The Activity window contains the following controls:

@ Open the Transfer Monitor. For more information on this feature, see Monitoring Transfers.

 Open the folder on your computer that contains this content.
* () Stop the transfer.
() Resume a stopped transfer, or retry a failed transfer.

When the queuing option is enabled, the number of concurrent transfers is limited. The additional transfers are queued
in the Activity window and initiated when a transfer is finished. You can manually start a queued transfer by clicking

the ) button. You can also right-click on a started or stopped transfer to access various controls. The example below
shows the right-click options for a stopped transfer.

[ NN | Activity - IBM Aspera Connect

w S IMG_4338.CR2

fUsersfjimirwin/Downloads/IMG_4338.CR2

IONONO;

Uploading 49.0 / 100.0 MB (9.32 Mbps) - 0:54 remaining 0:31 elapsed

k Stop
Show in Transfer Monitor
Open Containing Folder

Clear list
Go to: http://10.0.204.100/aspera/user/#
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Monitoring Transfers

From the Transfer Monitor window, Connect lets you monitor transfer progress. The Transfer Monitor provides a
graphical interface to adjust file transfer speed, adjust the minimum transfer rate, and set rate policy—all while the
transfer is in progress.

To monitor a transfer session shown in the Activity window, click the "> icon shown with the session. The Transfer
Monitor opens:

[ RN Transfer Monitor

Em- IMG_4335.CR2
JUsersfjimirwin/Downloads/iMG_4335.CR2 . aspera-env

Downloading 355.8 / 500.0 MB (43.90 Mbps) - 0:28 remaining 1:28 elapsed
100.00 Mbps

45.00 Mbps M

0 bps

Fair

The following controls are available in this window:

Open the folder on your computer that contains this content.
Stop the transfer.
Resume a stopped transfer, or retry a failed transfer.

If you have sufficient server privileges and your transfer server is configured to allow it, you can adjust or set your
desired transfer rate, minimum transfer rate, and rate policy. However, actual performance is subject to the available
bandwidth on your network as well as the transfer settings on your server:

Target transfer rate — To adjust the transfer rate, locate and select the upper slider o on the left side of the graph
and move it up or down to change the desired rate. Note that the actual rate depends on several factors.

Minimum transfer rate — To set the minimum transfer speed, locate and select the bottom slider e on the left
side of the graph and move it up or down to set the desired rate. The actual minimum rate depends on several
factors.
» Transfer policy — Select the transfer policy from the drop-down list at the bottom of the window. Note that your
specified rate policy may be subject to external limitations:
Fixed

The transfer transmits data at a rate equal to the target rate, although this may impact the
performance of other traffic present on the network.
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High
The transfer rate is adjusted to use the available bandwidth up to the maximum rate.

Fair
The transfer attempts to transmit data at a rate equal to the target rate. If network conditions do not
permit that, it transfers at a rate lower than the target rate, but no less than the minimum rate.

Low

The transfer rate is less aggressive than Fair when sharing bandwidth with other network traffic.
When congestion occurs, the transfer rate is decreased to the minimum rate, until other traffic
retreats.
» Additional options — Right-clicking in the area above the graph opens the same menu as doing so in the Activity
window, giving options such as stop or remove transfers, and open the transfer's containing folder.

File Encryption

Connect provides a means to protect files with Aspera encryption when the files are uploaded to a content-protected
server, and to decrypt those files when downloaded.

Whenever you upload files to a server configured as a content-protected host, Connect prompts you to create a
passphrase to protect the files with Aspera encryption. When you download those files, access to the files' contents
requires that you provide the passphrase to decrypt them. Files can be decrypted during the download transfer, or
decrypted after the download is complete. Files can be decrypted from within Connect, or by using the utility IBM
Aspera Crypt, which is included in the Connect installation.

Encrypting Files

Servers to which you want to upload encrypted files must be enabled for content protection. For more information,
see Content Protection.

When uploading files to a content-protected server, you are prompted for a passphrase to encrypt the files. You can
either enter the passphrase in the text field, or check Keep files unencrypted to proceed without using this feature (if
allowed by the server). To start the transfer, click OK.

[ ] Protected Content - IBM Aspera Connect

v Enter a passphrase to store files in an encrypted
Lt format on the server. A passphrase is required.
Passphrase esssss

Confirm R

Keep files unencrypted

WELLENy | Cancel

Once Aspera-encrypted files have been uploaded to your server, they can be identified by an additional file extension,
.aspera-env (Aspera Security Envelope).
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@ Welcome asperaweb (change user)

‘=4 aspera connect server

demo.asperasoft.com
g Download 4 Upload #Upload Folder g Delete o Mew Folder
Name Size Last Modified
g IMG_4333.CRZ.aspera-env 18MB Apr 3, 2018 9:03:00 PM
g IMG_4336.CRZ.aspera-env 18MB Apr 2, 2018 4:15:03 PM
g 10MB.3 10MB Now 16, 2017 10:11:34 AM
g 14601890.gif.aspera-env 4B80B Mar 19, 2018 3:13:33 PM

Decrypting Files During Download

When you use Connect to download a content-protected file, a window opens prompting you for a decryption
passphrase:

@ Protected Content - IBM Aspera Connect @ Protected Content - IBM Aspera Connect
i Enter a passphrase to decrypt protected files as i Enter a passphrase to decrypt protected files as
L they are downloaded. Lt they are downloaded.
Passphrase esssss | Passphrase
Keep files encrypted Keep files encrypted

L | Cancel WL | Cancel

You have two options:

» Enter the passphrase. In this case, Connect decrypts the files during the download. When the files arrive at their
destination, they are no longer encrypted, and no further steps are necessary.

» Check the Keep files encrypted box. In this case, Connect transfers the files to the destination in the encrypted
state. You don't need to enter a passphrase (if you do, it is ignored). With this option, the files retain the
.aspera-env extension on your disk. You can decrypt the files any time after the download has completed.

To proceed with the download, click OK. The Connect Activity window appears and shows the progress of the
transfer. When finished, the progress bar disappears, indicating the files are now at their destination.

Decrypting Files after Download

To decrypt downloaded files you have chosen to keep encrypted, run the IBM Aspera Crypt utility. You can launch
Crypt using any of the following methods:

* From the Connect Activity window: Once the transfer is complete, the Connect Activity window displays the link
Unlock encrypted files:
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| RN Activity - IBM Aspera Connect

w S IMG_4333.CR2

Done

@ IMG_4336.CR2

Unlock encrypted files ® ®

Done \

To launch Crypt, click Unlock encrypted files. This is the most convenient method for unlocking protected files
once they've been transferred. Depending on your preferences settings, you can also decrypt your files from here
later, as the transfer records remain in the Connect Activity window until you remove them by clicking Clear
List. However, the files remain only if under the Preferences > General you chose to remove transfer list items
Manually instead of automatically after transfer.

* By opening an Aspera-encrypted file: You can launch Crypt by opening an . aspera-env file from the context
menu or by double-clicking the file.

* From the Connect application menu: To open the application menu, click the Connect icon in the menu bar. To
launch Crypt, select Unlock encrypted files.

*  You can launch Crypt directly from the macOS Applications menu.

When you launch Crypt, the following window opens:

eCe © |IBM Aspera Crypt
Open Files Open Folder Settings

Passphrase .....d
L3

Show passphrase

0%  View: Latest ﬁ

L 0 finished, O failed, 1 pending, 1 total

If you launched Crypt from the Connect Activity window or by opening an aspera-env file, Crypt decrypts the
files that were selected. From the Crypt window, you can also select Open Files or Open Folder and browse for files
or folders to decrypt. When your encrypted contents are loaded into Crypt, a status message appears at the bottom of
the application, displaying the number of items ready for decryption.

To unlock protected content, fill in the encryption passphrase and click Decrypt. The files are unlocked and the
results displayed in the window:
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ey Q) |IBM Aspera Crypt

Open Files Cpen Falder Settings

Passphrase |.uusas Decrypt

Show passphrase

s 1009 View: Latest ﬁ

Finished -> /Users/jen/Downloads/

- iy
IMG_4336.CR2.aspera-env 100.0% IMG._ 4336 (decrypted).CR2

. 1finished, O failed, 0 pending, 1 total

The decrypted files are placed in the same directory as the original encrypted files:

[ NN [4) Downloads
< k 3 = iERER =
Back/Forward View Arrange Action  Share Add Tags
Favorites MName ~ Date Modified Size
¢ iCloud Drive IMG_4331.CR2 Apr 4, 2018 at 1:51 PM 104.9 MB
i | IMG_4333.CRZ2 Apr 3, 2018 at 9:12 PM 19.8 MB
@ AirDrop . . .
IMG_4335.CR2 Apr 4, 2018 at 1:49 PM 524.3 MB
&= Desktop @) IMG_4335.CR2.aspera-env Apr 4, 2018 at 5:12 PM 524.3 MB
@ Recents O IMG_4336.CR2 Today at 5:39 PM 19.8 MB
— -g, IMG_4336.CR2.aspera-env Apr 3, 2018 at 9:20 PM 19.8 MB
7% Applications m IMG_4336(decrypted) CR2 Today at 3:45 PM 19.8 MB

If you choose to decrypt a file and there is already an unencrypted file of the same name in that folder, the newly
decrypted version appears in the Crypt window and the folder listing with "(decrypted)" added to the filename, as in
the above example. However, note that if you decrypt the file yet again, the "(decrypted)" file is overwritten without
notice.

Maintaining Your Connect Installation

Upgrading Connect

When a new version becomes available, Connect prompts you to confirm whether to upgrade.

Note: Before upgrading, ensure that you have no previous Connect installations on your system — either single-user
or system-wide.

If Connect does not prompt you to upgrade (for example, because the system has no Internet access), you can

obtain an upgrade from the Aspera download site. To download the latest version of Connect, go to http://
downloads.asperasoft.com/connect. Click Download Now and follow the on-screen instructions. This downloads the
latest installer.


http://downloads.asperasoft.com/connect
http://downloads.asperasoft.com/connect
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You are also prompted to upgrade with the following pop-up if you attempt a download and Connect is not found or
otherwise unable to launch:

Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.9.5.

NEwW
Step 1 % Install Extension
Step 2 \I,

Step 3

Already installed? Troubleshoot

If Connect is not installed, or is out of date, you can download it from here by clicking Download latest version. If
Connect s already installed, you can click Troubleshoot to open the IBM Aspera Connect Diagnostic Tool. You can
also access the tool here:

https://test-connect.asperasoft.com/

Uninstalling

The Connect installation provides scripts for uninstalling Connect.

Uninstalling the Connect Application
Important: You must quit Connect before uninstalling it.

To uninstall Connect, quit both the Connect application and any open Web browsers. Then, run the corresponding
uninstall script below, based on whether you have a system-wide installation (multi-user) or a per-user installation.

Installation Method Path

System-wide installation $ sudo /Library/Application\ Support/Aspera/Asperal
(all users) Connect/uninstall connect.sh



https://test-connect.asperasoft.com/
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Installation Method Path

Per-user installation $ ~/Library/Application\ Support/Aspera/Aspera\ Connect/
uninstall connect.sh

Removing the Connect Browser Extension

For Chrome and Firefox, the browser extension is removed separately, as described below. However, for Safari, the
extension is removed when you uninstall Connect.

Chrome
To remove the extension from Chrome, click the three-dot icon in the upper right corner of the Chrome window.

Note: In certain circumstances, the default three-dot icon may not be visible while displaced by other icons. For
example, a circular yellow/orange icon with an arrow indicates Chrome needs to be updated.

In the drop-down menu that opens, choose More Tools > Extensions:

Mew Tab T
Mew Window HN
Mew Incognito Window TN
Histary k
Downloads NFEL
Bookmarks [
Zoom - 100% 4+
Print... HP
Cast...
Find... #F
Mare Tools 3 Save Page As... #S
Edit Cut Copy Paste
Settings 3, Clear Browsing Data... GHE
Help 3 Extensions
Task Manager k
Developer Tools A% o

The Extensions tab opens. Look for the panel with the Connect extension and click Remove:
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% Extensions x -+

® Chrome | chrome://extensions

— Extensions

IBM Aspera Connect
_@l Enable high-speed FASP transfers.

Details Remove ®

W

The Connect extension is now removed from Chrome.
Firefox

To remove the Connect extension for Firefox, open the three-bar icon in the upper right corner of the browser
window, and click Add-ons:
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¥ IN DO @ =
£ Signin to Sync
© Content Blocking Standard
£} New Window N
&2 Mew Private Window {r 3P
Zoom — 1w00% +
Edit ¥ Oy g
I\ Library >
=0 Logins and Passwords
493 Add-ons \ {3 A
-ﬁ- Preferences 3#,
,-‘" Customize...

The Add-ons Manager tab opens. Look for the panel with the Connect extension and click Remove:



| Maintaining Your Connect Installation | 31

&« G @ & Firefox about:addons o 4N

Find more extensions | Q Search addons.maozilla.or

<> Get Add-ons Manage Your Extensions

*‘ Extensions (@ Firefox is changing how extensions work in private browsing. Any new extensio

to Firefox won't run by default in Private Windows. Unless you allow it in settinc

Z Themes extension won't work while private browsing, and won't have access to your on

» activities there. We've made this change to keep your private browsing private.
Learn how to manage extension settings

Plugins

G IBM Aspera Connect Dieatia

Enable high-speed FASP transfers.
¥ Firefox Preferences

@ Add-ons Support

The Connect extension is now removed from Firefox.
Safari 12

The Connect browser extension for Safari is removed automatically when you uninstall the Connect application.

File Cleanup

You can safely remove old Connect files from your system.
Log Files
Log files are found in the following location. Log files can be removed at any time.

~/Library/Logs/Aspera Connect

Database File

If you previously installed Connect for all users (that is, system-wide), then when uninstalling, you will only be able
to remove the Connect database for the current user. To remove the database file for all users, you must locate and
remove the database file for each user account:

/Users/username/ .aspera/connect/connectdb.data

Alternatively, you can delete the entire . aspera directory after uninstalling Connect, if desired.
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Appendices

Log Files

You can access Connect log files from within Connect or from your file system.

Log Files

* aspera-connect.log

* aspera-scp-transfer.log

* nativemessagehost.log

* aspera-one-click-installer.log — log file for the quick installer

Log File Location

Log files are located in the following location:

~/Library/Logs/Aspera Connect/

You can also access the log folder from the Connect menu in the menu bar: &G > Open log folder
SBA® © 3 40 &
Activity 8T |

Unlock Encrypted Files 3R

Preferences... #BP
Check For Updates ®U
About... tF1
Quit #Q

For information on removing old log files, see File Cleanup.

Deploying Connect Extensions in Closed Environments

Locked-down or enterprise environments without access to the public internet generally require special steps to
acquire and enable Connect web extensions. Depending on OS platform and browser, there are a number of methods
for doing so.

Chrome
Method: Manual deployment Using Drag and Drop

1. Download the Connect extension CRX file from Connect download page.

2. Open chrome://extensions

3. Enable developer mode.

4. Drag-and-drop the CRX file into the chrome: //extensions window to install.

Method: Background deployment via preference file
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Requires network access to the Chrome update URLSs located here:
https://clients2.google.com/service/update2/crx
1. For user installs, run the following script:

#!/usr/bin/env bash
EXT ROOT="SHOME/Library/Application Support/Google/Chrome/External

Extensions"
mkdir -p "$EXT ROOT"
echo '{ "external update url": "https://clients2.google.com/service/

update2/crx" }' >_"$EXT_§OOT/kpoecbkildamnnchnlgoboipnblgikpn.json"

2. For machine installs, run this script using sudo:

#!/usr/bin/env bash

EXT ROOT="/Library/Application Support/Google/Chrome/External Extensions"
mkdir -p "$EXT ROOT"

echo '{ "external update url": "https://clients2.google.com/service/
update2/crx" }' > "SEXT ROOT/kpoecbkildamnnchnlgoboipnblgikpn.json"

3. Restart Chrome.
4. On startup, the extension must be enabled:

% 0 6@

"IBEM Aspera Connect" added

Another program on your computer added an extension that may change
the way Chrome works.

It can:
« Read and change all your data on the websites you visit

« Communicate with cooperating native applications

Remaove from Chrome Enable Extension

Note: If a user explicitly removes the extension, they are not prompted again and the extension is not installed.

Firefox
Method: Manual deployment

1. Download the Connect extension XPI file from Connect download page.
2. Open about:addons
3. From the menu, select Install Add-on From File.

Method: Deploying Aspera Connect add-on with custom build of Firefox


https://clients2.google.com/service/update2/crx
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See Mozilla documentation:

https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/
Distribution options/Add-ons in the enterprise#Bundling add-
ons_with a custom Firefox

Whitelisting the Chrome Extension

By default, all Chrome extensions are whitelisted. However, if your organization blacklists all extensions by policy,
you can override the blacklist and allow the Connect extension to be installed by adding it to the whitelist.

https://www.chromium.org/administrators/policy-
list-3#ExtensionInstallWhitelist

The instructional links below also include information on other extension-related policy settings that enable you to
automatically install Chrome, force-install Chrome, and so on.

Note: These policies are intended strictly for configuring instances of Google Chrome internal to your organization.
Use of these policies outside of your organization (for example, in a publicly distributed program) is considered
malware and will likely be labeled as malware by Google and anti-virus vendors.

Provisioning Policy Using Chrome Policy Templates

1. Install Chrome policy templates: Detailed instructions at:

https://support.google.com/chrome/a/answer/187202?hl=en

2. Set Chrome extension policies. Detailed instructions at:
https://support.google.com/chrome/a/answer/7517624
a. Create file com.google.chrome.plist in the following location:
/Library/Managed Preferences/com.google.chrome.plist
Insert the following contents in it:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://
www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>ExtensionInstallWhitelist</key>
<array>
<string>kpoecbkildamnnchnlgoboipnblgikpn</string>
</array>
</dict>
</plist>

b. Restart Chrome.
c. To verify that the policy has been applied, enter the following in the address bar:

chrome://policy
If the policy does not appear, try running the following:
$ sudo killall cfprefsd

Then restart Chrome.


https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Distribution_options/Add-ons_in_the_enterprise#Bundling_add-ons_with_a_custom_Firefox
https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Distribution_options/Add-ons_in_the_enterprise#Bundling_add-ons_with_a_custom_Firefox
https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Distribution_options/Add-ons_in_the_enterprise#Bundling_add-ons_with_a_custom_Firefox
https://www.chromium.org/administrators/policy-list-3#ExtensionInstallWhitelist
https://www.chromium.org/administrators/policy-list-3#ExtensionInstallWhitelist
https://support.google.com/chrome/a/answer/187202?hl=en
https://support.google.com/chrome/a/answer/7517624
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Troubleshooting

Connectivity Issues

SSH Connectivity Errors: "Timeout establishing connection”

If you receive the error "Timeout establishing connection,” the TCP connection between Connect and the server is
blocked (error codes 13, 15, or 40 in the log files). To determine the cause, open a Terminal or a Command prompt on
the client machine (where Connect is installed). Use telnet to test the connection to the server:

S telnet server-ip-address 33001
where server-ip-address is the IP address of the Aspera server (ex. 10.0.1.1) on TCP port 33001 (or the configured
TCP port, if other than 33001).

You will receive one of the following errors and can take the appropriate action:

* "Connection refused': The Aspera server is not running the SSHD service. Have your server administrator
review the server's SSH service status.

*  "Timeout": The client-side firewall is disallowing outbound TCP traffic. Ensure that the client-side firewall
allows outbound TCP traffic on port 33001 (or the configured TCP port).

UDP Connectivity Errors: "Data transfer timeout"
If Connect appears to successfully connect to the server but:

» The transfer progress reads 0%.
» Files appear to be transferred to the destination but are 0 bytes.
* You eventually receive the error "Data transfer timeout."

UDP connectivity is blocked, likely by the firewall configuration (error codes 14, 15, and 18 in the log files). Ensure
that the client-side firewall allows outbound traffic on the FASP UDP port (33001, by default) and the server firewall
allows inbound traffic on UDP port 33001.

IBM Aspera Connect Diagnostic Tool

Aspera provides a web-based diagnostic tool that can be useful for identifying connection issues. You can access the
tool here:

https://test-connect.asperasoft.com/

Transfer Issues

Connect Won't Transfer .partial Files

With the default configuration for Connect, if you try to transfer files that have a . partial extension, you'll notice
these files are skipped. This is because the . partial extension has special meaning for Connect. For a file in
transit, . partial is the default temporary extension for the partial file on the receiving end before its transfer is
complete. When the file's transfer is finished, the extension is removed.

You can transfer the skipped files by changing the name of the filename extension that Connect uses. Choose a name
that you don't expect will be used by files you transfer.

To make this change:


https://test-connect.asperasoft.com/
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1. Locate the Connect aspera.conf file on the machine at the receiving end of the transfer. The aspera.conf
file is included in the Connect installation. Open it with a text editor:

~/Applications/Aspera\ Connect.app/Contents/Resources/aspera.conf

2. Go to the line that begins with <partial file suffix>, and change .partial to a name your transfer
files will not be using:

<?xml version='1.0' encoding='UTF-8'?>
<CONF version="2">

<default>
<file system>
<storage rc>
<adaptive>
true
</adaptive>
</storage rc>
<resume suffix>.aspera-ckpt</resume suffix>
<partial file suffix>.partial</partial file suffix>
<replace illegal chars> </replace illegal chars>
</file system>
</default>

</CONE>

Note: Removing the <partial file suffix> entry or setting it to a null value will not necessarily
solve the problem. Doing so means the file extension used for partial files becomes whatever is set in the
aspera.conf for ascp, which by defaultis .partial.

3. Save your changes to the the Connect aspera.conf file. The changes will take effect with the next trtansfer.

Technical Support

Support Websites
For an overview of IBM Aspera Support services, go to https://asperasoft.com/company/support/.

To view product announcements, webinars, and knowledgebase articles, as well as access the Aspera Support
Community Forum, sign into the IBM Aspera Support site at https://www.ibm.com/mysupport/ using your IBMid
(not your company Aspera credentials), or set up a new account. Search for Aspera and select the product. Click
Follow to receive notifications when new knowledgebase articles are available.

Personalized Support

You may contact an Aspera support technician 24 hours a day, 7 days a week, through the following methods, with a
guaranteed 4-hour response time.

Email aspera-support@ibm.com

Phone (North America) +1 (510) 849-2386, option 2

Phone (Europe) +44 (0) 207-993-6653 option 2

Phone (Singapore) +81 (0) 3-4578-9357 option 2



https://asperasoft.com/company/support/
https://www.ibm.com/mysupport/
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LegalNoﬂce

©2008-2010- 2016- 2017- 2019 Aspera, Inc., an IBM Company. All rights reserved.

Licensed Materials - Property of IBM

5737-A72

© Copyright IBM Corp., 2008, 2016, 2017, 2019. Used under license.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.

Aspera, the Aspera logo, and FASP transfer technology are trademarks of Aspera, Inc., registered in the United

States. Aspera Drive, IBM Aspera High-Speed Transfer Server (a merger of IBM products formerly named Aspera
Connect Server and Aspera Enterprise Server, 2008 and 2007), IBM Aspera High-Speed Endpoint (formerly Aspera
Point-to-Point, 2006), IBM Aspera Desktop Client (formerly Aspera Client, 2005), Aspera Connect, Aspera Cargo,
Aspera Console, Aspera Orchestrator, Aspera Crypt, Aspera Shares, the Aspera Add-in for Microsoft Outlook, Aspera
FASPStream, and Aspera Faspex are trademarks of Aspera, Inc. All other trademarks mentioned in this document

are the property of their respective owners. Mention of third-party products in this document is for informational
purposes only. All understandings, agreements, or warranties, if any, take place directly between the vendors and the
prospective users.
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